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Chapter 1

Introduction
This guide shows you how to use the MSI installer to customize and deploy the following software:
l

SMART Notebook® 19 collaborative learning software

l

SMART Product Drivers

l

SMART Ink®

NOTE
Although it’s possible to use the USB installer (EXE), SMART recommends that you use the MSI
installation package to deploy the SMART software. The MSI installer was designed to support mass
deployments and provides finer control over the installation details for SMART software.
This guide is intended for those in charge of managing software subscriptions and installing software in a
school, such as technical specialists, IT administrators, and others experienced with customizing,
deploying, and administering software in a networked environment.
Use of this guide requires:
l

Knowledge of IT terminology, such as “registry” and “domain controller”

l

Knowledge of completing basic administrative tasks in Windows operating systems, such as
modifying the registry

l

Administrative privileges and access to servers

l

Access to the internet
IMPORTANT

The commands documented in this guide must be run in an Administrator Command Prompt window. To
open an Administrator Command Prompt window, right-click the Command Prompt icon, and then select
Run as Administrator.
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About the install components and software
This guide mentions a number of SMART software products and components that you’ll encounter when
deploying or updating SMART Notebook software:
Componenet/software

Description

Installer

USB or MSI installers, both available from the SMART website

SMART Ink

SMART’s digital ink software

SMART Product Drivers

SMART’s software that enables touch features for SMART’s interactive
products

SMART Install Manager

A tool you can use to customize the SMART software installation

SMART Product Update
(SPU)

A tool you can use to manage updates for SMART software products

SMART Uninstaller

A tool you can use to uninstall SMART software

smarttech.com/kb/171682

6

Chapter 2

Preparing for installation
Computer requirements
Network requirements
Setting up teacher access

7
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Before installing SMART Notebook, make sure the computer and network meets the minimum
requirements. Additionally, you’ll need to determine which activation method you want to use.

Computer requirements
Before you install the software, ensure the computer meets the following minimum requirements:
Windows® operating system
General
Supported operating systems

Windows 10
Windows 8.1
Windows 7 SP1 (with Platform Update KB2670838 and Security
Update KB3033929, or any future update that supersedes it).

Minimum hard disk space

4.7 GB

Minimum specs for standard and high definition displays (up to 1080p and similar)
Minimum processor

Intel® Core™ m3

Minimum RAM

4 GB

Minimum specs for ultra high definition displays (4K)
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Windows® operating system
Minimum graphics card

Discrete GPU
NOTE
SMART strongly recommends that your video card meets or
exceeds the preferred requirements. SMART Notebook can run
with an integrated GPU. However, your experience and SMART
Notebook’s performance can vary depending on the capabilities
of the GPU, your operating system, and other concurrently
running applications.

Minimum processor/system

Intel Core i3

Minimum RAM

8 GB

Other requirements
Programs

Microsoft® .NET Framework 4.5.1 or later for SMART Notebook
software and SMART Ink
Microsoft Visual Studio® Tools 2010 for Office for SMART Ink
Adobe Reader® 8.0 or later
DirectX® technology 10 or later for SMART Notebook software
DirectX 10 compatible graphics hardware for SMART Notebook
software
NOTES
l

l

Web Access

All prerequisite third-party software is built into the
installation executable and is automatically installed in the
correct order when you run the EXE.
These are the minimum requirements for SMART Learning
Suite, however SMART recommends updating to the most
recent versions of the software listed above.

Internet Explorer® 11 or later
Internet access to download and activate SMART software

NOTE
Operating systems and other third-party software released after this SMART software might not be
supported.

Network requirements
Ensure your network environment meets the minimum requirements on this page before you install or use
SMART Notebook.
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SMART Notebook’s interactive activities and assessments use hellosmart.com. Use the recommended
web browsers, device requirements, operating systems, and network capacity to ensure the best possible
experience with SMART Notebook’s interactive activities and assessments.
Additionally, some features of SMART Notebook and other SMART products (such as SMART Board
interactive displays) require access to specific web sites. You might need to whitelist those web sites if
your network restricts outbound internet access.
TIP
When using activities on hellosmart.com, students may check their website access at
hellosmart.com/connection/check.html.

Student device web browser recommendations
Students playing or participating in a SMART Notebook lesson’s activities and assessments should use one
of the following browsers on their devices:
The latest version of:
l

Google Chrome™

l

Safari

l

Firefox®

l

Windows 10 Edge
NOTE
Android™ devices must use Chrome or Firefox.

Ensure JavaScript is enabled in your browser.

Student device operating system recommendations
Students who use hellosmart.com should use one of the following recommended devices:
l

Any computer running the latest version of Windows 10 or any Mac running OS X 10.13 or later

l

Any iPad or iPhone upgraded to the latest iOS

l

Any Android™ phone or tablet with Android version 8 or later

l

Any Google™ Chromebook upgraded to the latest Chrome OS
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IMPORTANT
First-generation iPads or Samsung Galaxy Tab 3 tablets do not support mobile device-enabled activities.

Network capacity recommendations
SMART Notebook activities on hellosmart.com are designed to keep network requirements as low as
possible while still supporting rich collaboration. The network recommendation for Shout It Out! alone is 0.3
Mbps per device. A school that regularly uses other Web 2.0 tools should have enough network capacity
to run SMART Notebook activities on hellosmart.com.
If activities on hellosmart.com are used in conjunction with other online resources, such as streaming
media, greater network capacity could be required, depending on the other resources.

Website access requirements
A number of SMART products use the following URLs for software updates, collecting information, and
backend services. Add these URLs to your network’s whitelist to make sure SMART products behave as
expected.
l

https://*.smarttech.com (for updating SMART Board interactive display software and firmware)

l

http://*.smarttech.com (for updating SMART Board interactive display software and firmware)

l

https://*.mixpanel.com

l

https://*.google-analytics.com

l

https://*.smarttech-prod.com

l

https://*.firebaseio.com

l

wss://*.firebaseio.com

l

https://www.firebase.com/test.html

l

https://api.raygun.io

l

https://www.fabric.io/

l

https://updates.airsquirrels.com

l

https://ws.kappboard.com (for updating SMART Board interactive display software and firmware)

l

https://*.hockeyapp.net

The following URLs are used for signing in to and using your SMART Account with SMART products. Add
these URLs to your network’s whitelist to make sure SMART products behave as expected.
l

https://*.smarttech.com

l

http://*.smarttech.com
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l

https://hellosmart.com

l

https://content.googleapis.com

l

https://*.smarttech-prod.com

l

https://www.gstatic.com

l

https://*.google.com

l

https://login.microsoftonline.com

l

https://login.live.com

l

https://accounts.google.com

l

https://smartcommunity.force.com/

l

https://graph.microsoft.com

l

https://www.googleapis.com

The following URLs are used to enable content from YouTube. If you want SMART product users to be able
to insert and play YouTube videos when using SMART products, whitelist the following:
l

https://*.youtube.com

l

https://*.ytimg.com
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Setting up teacher access
Before you download and install SMART Notebook, you’ll need to determine how you want to set up
access for the teacher. There are two ways to activate a teacher’s access to SMART Notebook:
l

Email provisioning: provision the teacher’s email address for their SMART account

l

Product key: use a product key

SMART recommends that you provision a teacher’s access using their SMART account email rather than a
product key. For a comparison of the activation methods and help determining which is best for you, see
Appendix A: Determining the best activation method on page 43.
NOTE
Setting up access doesn’t apply if you are using SMART Notebook in trial mode.
After you’ve determined which activation method is best for your school, sign in to the SMART Admin
Portal to provision teachers or locate the product key.
The SMART Admin Portal is an online tool that allows schools or districts to easily manage their SMART
software subscriptions. After signing in, the SMART Admin Portal shows you details, including:
l

all the subscriptions you or your school has purchased

l

the product key(s) attached to each subscription

l

renewal dates

l

number of seats attached to each product key and how many of those seats have been assigned to
users

To learn more about the SMART Admin Portal and its use, visit
support.smarttech.com/docs/redirect/?product=softwareportal.
NOTE
If you download and install SMART Notebook but don’t set up access, the basic version of
SMART Notebook is installed with a bonus 45-day access to all of SMART Notebook’s subscriptionbased features. These features will become unavailable after the 45-day period ends. To learn more
about SMART Notebook basic version and premium features, see
support.smarttech.com/docs/redirect/?product=notebook&context=explainsubscription).
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Adding teachers to a subscription
If you chose to provision a teacher’s email to set up access, you need to add the teacher to the
subscription in the SMART Admin Portal.
You can add one teacher at a time to the subscription or use a CSV file to add multiple teacher’s at once.
To add a single teacher to the subscription
1. Sign in to the SMART Admin Portal at adminportal.smarttech.com.
2. Click the Manage users link in the Assigned/Total column for the subscription to which you want to
assign users.

3. Click Add users.
4. Select Type email addresses.
5. Type the teacher’s email address and click Add.
Ideally, this email is the one provided to the teacher by their school for Google Suite or Microsoft
Office 365.
Later, after you’ve downloaded and installed SMART on the teacher’s computer, let the teacher know
which email you’ve provisioned. The teacher will use this email to create or sign in to their SMART
account and activate their full access to SMART Notebook.
6. If you’re provisioning the account of a teacher at your school, let the teacher know which email
address you’ve provisioned in the portal and ensure the teacher uses that email address to set up their
SMART account.
To add multiple teachers to the subscription
1. Sign in to the SMART Admin Portal at adminportal.smarttech.com.
2. Click the Manage users link in the Assigned/Total column for the subscription to which you want to
assign users.

3. Click Add users.

smarttech.com/kb/171682
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4. Select Import CSV file.
NOTE
Ensure the CSV file complies with the following:
o

Includes a single column of email addresses, with each address on its own line.

o

Doesn’t include titles or headers.

o

Doesn’t include spaces, commas, or quotation marks.

5. Select the CSV file and click Open.
6. If you’re provisioning accounts for teachers at your school, let teachers know which email addresses
you’ve provisioned in the portal and ensure they’ve used those email addresses to set up their
SMART accounts.
NOTE
Users sign in to SMART software using the email addresses you enter here.

Locating the product key for activation
If you chose the product key method to set up access, sign in to the SMART Admin Portal to locate the key.
To locate the product key for your subscription
1. Go to subscriptions.smarttech.com and enter your user name and password for the SMART Admin
Portal to sign in.
2. Locate your subscription to SMART Learning Suite and expand it to view the product key.

See the SMART Admin Portal support page for complete details about using the portal
(support.smarttech.com/docs/redirect/?product=softwareportal).
3. Copy the product key and email it to the teacher or save it in a convenient location for later. You or the
teacher will enter this key in SMART Notebook after it’s installed.

smarttech.com/kb/171682

14

Chapter 3

Downloading and installing
Downloading the installation files
Preparing language files for non-English deployments of SMART Notebook
Activation connectivity
Installing required third-party packages

15
15
16
16

Downloading the installation files
All installation files are available for download from the SMART website.
To download the installer files
1. Go to smarttech.com/products/education-software/smart-learning-suite/admin-download.
2. Select the latest version of SMART Notebook.
3. Select Windows as the operating system.
4. Select the MSI installer.
5. Click DOWNLOAD - WINDOWS.
6. Extract and save the installation packages to a network location that’s accessible to all computers on
which you plan to install the software. When the third-party installation packages are extracted, you’ll
find them in the root of the Support folder.

Preparing language files for non-English deployments of SMART Notebook
When using the MSI installer to deploy the installation packages for a language other than English (U.S.),
ensure all MST files are in the same folder as the MSI file.
Similarly, if you want users to be able to view and use the handwriting recognition feature in a language
other than English, you must install the appropriate handwriting recognition resources. Handwriting
resources are included in the zipped MSI Installer downloaded in the previous procedure.
If you deploy any handwriting recognition resources, ensure the Support\Language folder exists in the root
of the admin.zip file and that the folder structure is intact if you install handwriting languages. This allows the
administrator installer to find the resources to install.
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Refer to Appendix D: Language files and codes on page 51 for a reference table on language MST files
and handwriting codes.

Activation connectivity
When you deploy SMART Notebook software, make sure the computers can access SMART’s web
activation services (see Website access requirements on page 10). Otherwise, the computers will not be
able to activate product keys during or after installation.
TIP
The SMART Install Manager and Activation Wizard will test the required URLs and indicate success or
failure. When you use the SMART Install Manager tool, consider that you, as an administrator, may have
less-restricted access to the internet than standard users. It is important to install SMART Notebook
software on a standard user’s computer and use the Activation Wizard connectivity tester to confirm
connectivity.

Installing required third-party packages
Before you deploy SMART Notebook, deploy the following required third-party installation packages:
Third-party package

Why it’s required

Microsoft .NET Framework 4.5.1 files
(dotNetFx451_Full_setup.exe)

SMART Notebook software and SMART Ink will not run
without this installed.

Microsoft Visual Studio Tools for Office (vstor_
redist.exe)

SMART Ink add-ins for Microsoft Office will not work
without this installed.

The MSI installer includes separate installers for third-party software in the Support folder of the unzipped
files you downloaded from the SMART website.
You can use the command-line interface to deploy installation packages in many ways, such as by running
commands from the command prompt or by including commands in batch script files.
To install the Microsoft .NET Framework 4.5.1 files
NOTE
For information about deploying the Microsoft .NET Framework, refer to the .NET Framework
Deployment Guide for Administrators on the MSDN website (msdn.microsoft.com/enus/library/ee390831.aspx). An internet connection is required for downloading and installing the full
.NET package.
Run the following command to install the files in UI mode:

smarttech.com/kb/171682
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[Path]\dotNetFx451_Full_setup.exe /passive /showfinalerror
OR
Run the following command to install the files in silent mode:
[Path]\dotNetFx451_Full_setup.exe /q
Where [Path] is the path to the dotNetFx451_Full_setup.exe file.
To install Microsoft Visual Studio Tools
Run the following command:
[Path]\vstor_redist.exe /q
Where [Path] is the path to the vstor_redist.exe file.

smarttech.com/kb/171682
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You can use SMART Install Manager or a variety of third-party tools to customize the deployment.

Using the SMART Install Manager
The SMART Install Manager is a tool you can use to customize the installation of SMART Notebook and its
components during network deployments.
The SMART Install Manager is included with the zipped MSI installer download file, or you can download it
separately from the SMART website.
You can use the MSI installer to:
l

Open and customize the installer

l

Save your configuration changes as an XML file

l

Publish your changes to the installation package as an MST file

smarttech.com/kb/171682
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Downloading the SMART Install Manager
You can download the SMART Install Manager directly from the SMART website.
To download SMART Install Manager
1. Go to smarttech.com/products/education-software/smart-learning-suite/admin-download.
2. Select the latest version of SMART Notebook.
3. Select Windows.
4. Select SMART Install Manager.
5. Click DOWNLOAD - WINDOWS and then save the EXE file to your computer.
6. Double-click the EXE file.
7. Follow the on-screen instructions.

Using the SMART Install Manager to customize SMART Notebook
installations
Use the following instructions to customize SMART Notebook installations.
TIP
You can save your progress as an XML file when customizing the installation and continue the process
later. However, after you publish the customized install file as an MST, you cannot reopen the MST and
edit it.
To customize a SMART Notebook installation using the SMART Install Manager
1. Start the SMART Install Manager.
2. Drag the MSI installer (SMARTLearningSuite.msi) into the SMART Install Manager window.
3. Set the controls on each page (see SMART Install Manager controls on the next page).
4. Click File > Save As.
5. Browse to the location where you extracted the MSI installation package.
IMPORTANT
When publishing an MST file, the MST file must be saved to the same location as the extracted MSI
installer.
6. Type a name for the file and click Save to create and publish the MST file.
7. Close the SMART Install Manager.
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To update an existing customized XML file using the SMART Install Manager
1. Start the SMART Install Manager.
2. Select File > Open and browse to the location of the XML file.
3. Select the file and click Open.
4. Edit the controls as needed.
5. Select File > Publish.
6. Using the Save As dialog box, browse to the location where you want to publish the customized MST
file.
NOTE
When publishing an MST file, save the MST file to the same location as the MSI installer.
7. Type a name for the file and click Save to create and publish the MST file.
8. Close the SMART Install Manager.

SMART Install Manager controls
Use the information in the following table to customize the installation of SMART Notebook using the
SMART Install Manager.
Control

Procedure

Notes

General Options: Product Selection
SMART Product Drivers

Select to install SMART Product Drivers.

If the teacher will use the computer with a SMART
Board interactive display, SMART Product Drivers is
required.

SMART Ink

Select to install SMART Ink.

If you install SMART Ink, you must install SMART
Product Drivers.
When you select this option, SMART Install Manager
selects SMART Product Drivers automatically.

SMART Notebook
software

Select to install SMART Notebook software.

Required

Product key

Type your 25-character product key for SMART
Notebook software.

You can type the product key with or without
hyphens.
The installation uses this key to activate the software.
This option is only available if you chose to use
product key activation instead of provisioning users
in the SMART Admin Portal (recommended).

SMART response 2

smarttech.com/kb/171682
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Control

Procedure

Notes

SMART Notebook Math
Tools

Select to install SMART Notebook Math Tools
software.

If you choose to install SMART Notebook Math Tools
software, you must also install SMART Notebook
software.

NOTE
This software is discontinued.
Product key

Type your 22- or 25-character product key for
SMART Notebook Math Tools software.

You can type the product key with or without
hyphens. When you type a volume product key, the
software activates when you deploy it to network
computers.

Remove SMART
products that aren’t
selected above if they
exist on the system

Select to remove SMART software products
available in the current SMART Learning Suite
package found on any computer on your system
(except the SMART products you select).

This affects the behavior of the installer when you
perform an upgrade. It enables you to remove any
software in the current SMART Learning Suite
package that you haven’t specifically selected for
installation.

Delay activation

Select to register the product keys on a computer
without activating them. Registered keys can be
activated when users start SMART Notebook
software.

Delaying activation is useful for uniform deployments
that include users who don’t use SMART Notebook
software. Only users who start SMART Notebook
software will activate registered keys and use a seat
from your school’s subscription.

If you don’t select this setting, the software activates
automatically during installation rather than
manually after installation.
Disable the License
Status dialog box

Select to prevent the software activation reminder
from appearing after SMART Notebook software
starts.

When this option is selected, the software activation
reminder appears only after the SMART Notebook
software trial period has ended.

Allow users to start
SMART Learning Suite
45-day trials

Select to allow users to start a trial of SMART
Learning Suite.

A trial provides users with access to the additional
SMART Notebook features that come with the
subscription.

Show SMART Learning
Suite subscription expiry
warnings and renewals

Select to enable in-product notifications when a
SMART Learning Suite subscription is about to
expire.

If enabled, SMART Notebook will display a
notification for upcoming subscription expiry at at 95,
55, 25, and 15 days before the expiry date. This
notification is only displayed once for each time
interval.

General Options: Installation Options
Installation directory

Type the path to the preferred folder where
program files are installed.

If you specify a folder, include a back slash (\) at the
end of the path.

After you specify the path, selected programs are
installed in subdirectories of this location.

If you don’t specify a folder, Windows Installer uses
subdirectories of the default folder:
l

l

C:\Program Files\SMART Technologies (32-bit
systems)
C:\Program Files (x86)\SMART Technologies
(64-bit systems)
IMPORTANT

Ensure the folder path valid. The SMART Installer
Manager doesn’t verify the folder path.

smarttech.com/kb/171682
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Control

Procedure

Notes

Start SMART System
Menu at logon

Select to start the SMART System Menu when the
user logs on.

[N/A]

SMART Technologies
Error Report

Select to enable the SMART Technologies Error
Report.

This application is installed by default as part of the
installation.

Install desktop shortcuts

Select to create shortcuts on the desktop.

This option creates shortcuts on the desktop.

General Options: Network/Firewall Settings
SMART activities

Adds the URLs to your teacher and student
network’s whitelist.

See the complete list of whitelisted websites
provided at the beginning of this guide (see page 10).

This setting confirms that the SMART activities
features work correctly in SMART Notebook.
General Options: Language selection
Select the handwriting
recognition resources
you want to install

Select the handwriting recognition resources that
are installed with SMART Notebook.

You can select up to 18 handwriting recognition
resources if you’re running an administrator
installation with the SMARTLearningSuite.msi file
(see smarttech.com/kb/170081).

General Options: SMART Product Update
Install SMART Product
Update in Full mode

Select to install SMART Product Update (SPU) in Full
mode.

In Full mode, SPU shows which SMART software is
installed, the software’s activation status (if
applicable), and indicates whether updates are
available.
TIP
If teachers don’t have administrative privileges
and therefore cannot install updates themselves,
consider installing SPU in Dashboard mode
(described in the next item).

Install SMART Product
Update in Dashboard
mode

Select to install SPU in Dashboard mode.

In Dashboard mode, SPU shows which SMART
software is installed and the software’s activation
status is (if applicable). It does not indicate availability
of updates for the installed software.
This option is most used in situations where
individual teachers don't have administrative
privileges for their computers and can't install
updates.

Do not install SMART
Product Update

Select to not install SPU.

[N/A]

Check for updates

Type the interval in days (1 to 60) between SPU
checks.

This option is available only if you install SPU in Full
mode.
By default, SPU checks for product updates every 30
days.

Notify users about
SMART product updates

smarttech.com/kb/171682
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Control

Procedure

Notes

Reset per-user changes
to the previous two
settings

Select to remove existing Check for updates and
Notify users about SMART product updates
values the next time the user runs SPU.

This enables you to push new values for these
settings to computers and ensures that the new
values are accepted.
Individual teachers can still modify these settings.

General Options: Customer Experience
Enable the Customer
Experience Program on
all devices

Select to automatically enable the Customer
Experience Program for all users.

[N/A]

Disable the Customer
Experience Program on
all devices

Select to automatically disable the Customer
Experience Program for all users.

[N/A]

SMART Notebook: Gallery Content
Gallery Essentials

Select to install the Gallery essentials pack.

The Gallery includes a wide variety of resources for
teachers. See Appendix C: Installing and maintaining
Gallery content on page 47 .

Lesson Activity Toolkit

Select to install the Lesson Activity Toolkit widget.

This widget provides teachers with objects they can
use to build simple interactive activities for their
lessons.

Team Content Path

Type the path to the Team Content folder, which is a
location on your school’s network where teachers
can store shared content.

See Appendix C: Installing and maintaining Gallery
content on page 47 .

My Content Path

Type the path to the My Content folder, the location
on the teacher’s computer where the teacher can
store custom content.

See Appendix C: Installing and maintaining Gallery
content on page 47 .

SMART Notebook: Optional Settings
Install print capture
driver

Select to include the Print Capture Driver in the
installation.

The Print Capture Driver installs two virtual printer
drivers that allow users to export content from any
Windows program. The driver provides two options:
l

l

Send to SMART Cloud: allows teachers to
share a document to a SMART Board or as a
link.
Send to SMART Notebook: allows users to
export a document to SMART Notebook.

Register SMART
Document Camera
drivers

Select to enable the registration of SMART
Document Camera™ drivers.

Disable the registration of SMART Document
Camera drivers if they conflict with the third-party
drivers on the computer.

Update the Windows
Firewall exception list

Select if teachers at the school are also using
SMART Notebook Maestro.

This property updates the Windows Firewall
exception list for Domain and Private networks.
It allows NBSDK to listen on all IP address on a
machine (instead of just localhost) and adds firewall
rules to permit incoming connections to NBSDK.

SMART Product Drivers: Optional Settings
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Control

Procedure

Notes

Enable Tablet PC
Support

Select to use Tablet PC features with the SMART
Board interactive display without having to connect
a Tablet PC.

This option applies to the Windows 7 operating
system and has no effect on other operating
systems.

Start SNMP Agent
services at logon

Select to enable SNMP Agent services.

[N/A]

SMART Ink: Optional Settings
Start SMART Ink at logon

Select to start SMART Ink when the user logs on to
the computer.

[N/A]

Using third-party tools
You can customize SMART software installation packages by using the Windows Installer properties and by
using a third-party tool, such as Orca database editor, to create MST files. See Appendix E: Windows
Installer properties on page 54.
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You can deploy the software using one of the following methods:
l

Deploy the MSI installer using the command-line interface.

l

Deploy the MSI installer using third-party imaging or remote management software.
IMPORTANT

If you are deploying SMART Product Drivers, the user must log off and log back on after you deploy the
software to start the SMART Board Service. In addition, if an error message appears after you deploy the
software stating that the SMARTBoardService.exe file could not be found, the user can close this error
message. This message appears only when the computer is not connected to a SMART Board
interactive display.

Deploying the software using the command-line
interface
Using the command-line interface, you can deploy installation packages in many ways, such as by running
commands from the command prompt or by including commands in batch script files.
To use the command-line interface to deploy SMART software with the MSI installer
Run the following command if you created an MST file to customize the installation package:
msiexec /i "[Path]\SMARTLearningSuite.msi" TRANSFORMS="[MST file]" [Parameter]
OR
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Run the following command if you didn’t create an MST file to customize the installation package:
msiexec /i "[Path]\SMARTLearningSuite.msi" [Properties][Parameter]
Where
o

[Path] is the path to the SMARTLearningSuite.msi file and MST file.

o

[MST file] is the name of the MST file.

o

[Properties] is a set of properties you can include to customize the installation (see Appendix E:
Windows Installer properties on page 54).

o

[Parameter] is the installation parameter (see page 26).

Windows Installer parameters
The following are the standard Windows Installer parameters for the msiexec command.
Parameter

Use

/q

Hide the installation wizard and the dialog box that signals the end of the installation.
NOTE
This is Silent mode.

/qn

Same as /q.

/qn+

Hide the installation wizard but show the dialog box signaling the end of the
installation.

/qb

Show a basic installation wizard.

/qb!

Show a basic installation wizard without a Cancel button.

/qb+

Show a basic installation wizard with a dialog box signaling the end of the
installation.

/qb+!

Show a basic installation wizard with a dialog box that signals the end of the
installation but no Cancel button.

/qr

Show a reduced installation wizard.

/qf

Show the full installation wizard, including a dialog box signaling the end of the
installation or the Fatal Error, User Exit or Exit dialog box.
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Examples
The following example installs SMART Notebook software and SMART Product Drivers in Silent mode:
msiexec /i "[Path]\SMARTLearningSuite.msi /q
The following example installs the default software products, SMART Notebook software, SMART Product
Drivers, SMART Ink, Gallery Essentials, and Lesson Activity Toolkit:
msiexec /i "[Path]\SMARTLearningSuite.msi" INSTALL_NOTEBOOK=1 INSTALL_BOARD=1 INSTALL_
INK="" LAT_CONTENT="" FULL_GALLERY=""

Using third-party imaging or remote management software
The following procedure shows how to deploy SMART software using Group Policy-based deployment
software. For information on deploying SMART software using your organization’s third-party imaging or
remote management software, see the software’s documentation.
NOTES
l

This procedure may vary depending on your version of Windows operating system and your system
preferences.

l

Ensure your domain controller has Windows Installer 4.5.

To deploy an installation package
1. Copy all contents of the admin .zip file (including subfolders) to \\[Domain Controller]\NETLOGON,
where [Domain Controller] is your domain controller.
IMPORTANT
If you want users to be able to view and use the handwriting recognition feature in a language other
than English, you must also copy the Support folder to \\[Domain Controller]\NETLOGON.

The installer looks for handwriting recognition resources in the Support folder only. The Support
folder is located in the downloaded .zip file.

Also, for both Gallery and Lesson Activity Toolkit to install and operate successfully, verify that all
folders and subfolders of the Support folder is copied over.
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It is important you follow these guidelines to ensure a successful installation:
o

You must maintain the Support folder structure.

o

The Support folder must reside in the root of the folder where the MSI file is stored.

2. Open Control Panel, double-click Administrative Tools, and then double-click Active Directory Users
and Computers.
The Active Directory Users and Computers window appears.
3. Right-click your domain, and then select Properties.
The Properties dialog box appears.
4. Click the Group Policy tab, and then click Edit.
The Group Policy Object Editor dialog box appears.
5. Browse to Computer Configuration\Software Settings.
6. Right-click Software Installation, select New > Package, and then browse to and select the MSI file
from step 1.
7. In the Deploy Software section, click Advanced, and then click OK.
8. Click the Modifications tab, click Add, and then browse to and select the MST file from step 1.
9. Click OK to apply the MST file to the MSI file.
10. Close all open windows and dialog boxes.
The next time each computer on the domain starts, the computer automatically installs the software in
Silent mode with the customizations defined in the MST file.

Deploying the software using third-party imaging or
remote management software
This procedure shows how to deploy SMART software using Group Policy-based deployment software.
For information about deploying SMART software using your organization’s third-party imaging or remote
management software, see the software’s documentation.
NOTES
l

This procedure may vary depending on your version of Windows operating system and your system
preferences.

l

Ensure your domain controller has Windows Installer 4.5 or higher.
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To deploy the MSI installer using group policy
1. Copy all contents of the admin .zip file (including subfolders) to \\[Domain Controller]\NETLOGON,
where [Domain Controller] is your domain controller.
IMPORTANT
o

If you want users to be able to view and use the handwriting recognition feature in a language
other than English, you must also copy the Support folder to \\[Domain
Controller]\NETLOGON.

o

The installer looks for handwriting recognition resources in the Support folder only. The
Support folder is located in the downloaded .zip file.

o

To make sure both Gallery and Lesson Activity Toolkit install and operate correctly, verify that
all folders and subfolders of the Support folder is copied over.

o

It is important you follow these guidelines to ensure a successful installation:
o

You must maintain the Support folder structure.

o

The Support folder must reside in the root of the folder where the MSI file is stored.

2. Open the Active Directory Users and Computers window from the Windows Control Panel under
Administrative Tools.
3. Right-click your domain, and then select Properties. The Properties dialog box opens.
4. Open the Group Policy tab, and then click Edit. The Group Policy Object Editor dialog box opens.
5. Browse to Computer Configuration\Software Settings.
6. Right-click Software Installation, select New > Package, and then browse to and select the MSI file
from step 1.
7. In the Deploy Software section, click Advanced, and then click OK.
8. Click the Modifications tab, click Add, and then browse to and select the MST file from step 1.
9. Click OK to apply the MST file to the MSI file.
10. Close all open windows and dialog boxes.
The next time each computer on the domain starts, the computer automatically installs the software in
Silent mode with the customizations defined in the MST file.
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Depending on the activation method you chose (provisioning or product key), you can activate a teacher’s
access either during deployment or after.

Activating by provisioning teachers
Activation is managed through the SMART Admin Portal and can take place either before or after SMART
Notebook is deployed.
When performing mass deployments of SMART Notebook, activation requires minimal work if you’ve
chosen to provision the teacher’s email address rather than use product keys.
To activate a teacher’s access to SMART Notebook when their email has been provisioned
1. Provision each teacher’s email address in the SMART Admin Portal before you install the software.
See page 13.
2. After a teacher’s email has been provisioned, give that address to the teacher and have the teacher
use it to create a SMART account. See Appendix B: Help teachers set up a SMART account on
page 45.
3. Have the teacher sign in to their SMART account in SMART Notebook.
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Activating using a product key
If you want to activate SMART Notebook software during deployment, you can use either of the following
practices, depending on your deployment method:
l

System imaging

l

Network deployment

Activating when using the system imaging deployment
If you are using a system imaging method to deploy SMART Notebook, do not activate the software
before you freeze the image. Activation is linked to the hardware identifier of the computer on which the
software is installed and activated. If you clone a hard drive image that has software which has been
installed and activated, you must activate the software on each cloned computer after installation.
To activate Notebook when using the system imaging deployment method
1. Before freezing the image, use the SMART Install Manager’s Delayed Activation option to register
your product key on the system (see Delay Activation in the table under SMART Install Manager
controls, page 21).
IMPORTANT
Do not activate the software before you freeze the image.
2. Deploy the image.
After the image is deployed, SMART Notebook software will prompt you to activate the registered
product key (see Delay Activation in the table under SMART Install Manager controls, page 21).
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Activating when using the network deployment method
To activate Notebook when using the network deployment method
If you use a network deployment tool, such as Group Policy software installation, startup scripts, or
Microsoft SCCM, you can specify your product key normally in the SMART Install Manager (see Using
the SMART Install Manager on page 18).
OR
Run the following command:
"C:\Program Files (x86)\Common Files\SMART Technologies\SMART Activation
Wizard\activationwizard.exe"--puid=notebook_14 --m=[Value] --v=5 --a [Optional
flags] --pks="[Product keys]"
Where
o

[Value] is 4 to run the activation wizard in unattended mode.
OR
[Value] is 6 to run the activation wizard in user interface mode.

o

o

[Optional flags] are options you can include to configure the activation wizard:
Flag

Purpose

--monitor=Number

Specify the monitor to display the activation wizard.

--proxy=Host:Port

Specify the proxy host and port number to use for activation.

--proxyuser=User

Specify the proxy user name to use for activation.

--proxypassword=Password

Specify the proxy password to use for activation.

--locale=Code

Display the activation wizard user interface in a specific language, where
[Code] is your language code (see Installation language files and codes
on page 51).

Where [Product keys] are one or more software product keys, separated by commas.

Activation will occur during installation on each computer.
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Troubleshooting the activation after software installation
There are two situations in which the software doesn’t activate completely:
l

Imaging a computer: The software was activated before the computer’s image was frozen.

l

Reverting a computer to an earlier state: If you use system recovery or protection software that
periodically restores the computer to an earlier state, you might need to activate the software before
locking the computer to prevent the activation record from being cleared each time the computer is
restored.

Run the activation wizard while the computer is connected to the network or complete the following
procedure to activate the software on each computer.
NOTE
SMART Product Drivers and SMART Ink don't require activation.
To activate SMART software after installation
Run the following command:
"C:\Program Files (x86)\Common Files\SMART Technologies\SMART Activation
Wizard\activationwizard.exe"--puid=notebook_14 --m=[Value] --v=5 --a [Optional
flags] --pks="[Product keys]"
Where
o

[Value] is 4 to run the activation wizard in unattended mode.
OR
[Value] is 6 to run the activation wizard in user interface mode.

o

o

[Optional flags] are options you can include to configure the activation wizard:
Flag

Purpose

--monitor=Number

Specify the monitor to display the activation wizard.

--proxy=Host:Port

Specify the proxy host and port number to use for activation.

--proxyuser=User

Specify the proxy user name to use for activation.

--proxypassword=Password

Specify the proxy password to use for activation.

--locale=Code

Display the activation wizard user interface in a specific language, where
[Code] is your language code (see Installation language files and codes
on page 51).

Where [Product keys] are one or more software product keys, separated by commas.
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Activating SMART Notebook Math Tools
SMART Notebook Math Tools have been discontinued, and new product keys are no longer available for
purchase. However, if you have an existing product key for Math Tools, use this procedure to activate Math
Tools.
To activate only SMART Notebook Math Tools software after installation
Run the following command:
"C:\Program Files (x86)\Common Files\SMART Technologies\SMART Activation
Wizard\activationwizard.exe"--puid=notebook_14 --m=[Value] --v=5 --a [Optional
flags]--pks="[Product keys]"
Where
o

[Value] is 4 to run the activation wizard in unattended mode.
OR
[Value] is 6 to run the activation wizard in user interface mode.

o

o

[Optional flags] are options you can include to configure the activation wizard:
Flag

Purpose

--monitor=Number

Specify the monitor to display the activation wizard.

--proxy=Host:Port

Specify the proxy host and port number to use for activation.

--proxyuser=User

Specify the proxy user name to use for activation.

--proxypassword=Password

Specify the proxy password to use for activation.

--locale=Code

Display the activation wizard user interface in a specific language, where
[Code] is your language code (see Installation language files and codes
on page 51).

Where [Product keys] are one or more software product keys, separated by commas.

Checking for and applying renewals for product keys
If your school has purchased maintenance or subscription licenses, SMART software attempts to renew the
licenses automatically every 24 hours whenever SMART Notebook is running, or the next time SMART
Notebook is started. However, you can run a command to check for renewals explicitly. Using a command
line, you can renew all keys or specific keys.
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TIP
Use SMART Product Update (SPU) to retrieve the activation status for SMART Notebook. See
smarttech.com/kb/171533.
To check for and apply renewals for all keys using a command line
For unattended installations, run the following command:
"C:\Program Files (x86)\Common Files\SMART Technologies\SMART Activation
Wizard\activationwizard.exe" --m=15 --v=5--renewal-mode=all
OR
For user interface mode, run the following command:
"C:\Program Files (x86)\Common Files\SMART Technologies\SMART Activation
Wizard\activationwizard.exe" --m=16 --v=5--renewal-mode=product --puid=notebook_14
--uipack=notebook_10

To check for and apply renewals for specific keys using a command line
For unattended mode installations, run the following command:
"C:\Program Files (x86)\Common Files\SMART Technologies\SMART Activation
Wizard\activationwizard.exe" --m=15 --v=5--renewal-mode=product --puid=notebook_
14 --pks="[Product keys]"
Where [Product keys] are one or more software product keys separated by commas.
OR
For user interface mode, run the following command:
"C:\Program Files (x86)\Common Files\SMART Technologies\SMART Activation
Wizard\activationwizard.exe" --m=16 --v=5--renewal-mode=product --puid=notebook_14
--uipack=notebook_10 --pks="[Product keys]"
Where [Product keys] are one or more software product keys separated by commas.
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Returning activations
If you gave teachers access by provisioning them, use the SMART Admin Portal to remove a teacher from
a subscription and return the seat to the subscription. If you used the product key method to activate a
teacher’s access, you can use the command-line script to return the product key. To learn more about
removing teachers from a subscription, visit the SMART Admin Portal support page
(support.smarttech.com/docs/redirect/?product=softwareportal)

Returning activations when using the provision email method
Returning a teacher’s access is managed in the SMART Admin Portal. To do this, visit
adminportal.smarttech.com and sign in to the SMART Admin Portal. Then, follow the instructions on the
SMART Admin Portal’s support page (see
support.smarttech.com/docs/redirect/?product=softwareportal&context=AddRemoveUsers).

Returning activations when using the product key method
You can deploy an activationwizard.exe command across the network to return the activation from several
computers, making the product key available for use on other computers.
You can specify multiple keys in one command by using the command format below.
To return product keys
Run the following command:
"C:\Program Files (x86)\Common Files\SMART Technologies\SMART Activation
Wizard\activationwizard.exe" --puid=notebook_14 --m=4 --v=5 --return --pks="
[Product keys]"
Where [Product keys] is one or more software product keys separated by commas.
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SMART periodically releases updates to its software. These updates add new features and resolve issues.
SMART may provide updates in two file formats in the installation package:
l

Windows Installer update installation packages (MSI files)

l

Windows Installer patches (MSP files)

MSI is the most common installation package available, and this guide provides instructions only for
updating using MSI files. The less common MSP files are available only for select updates as identified on
the SMART website. If an MSP update is provided, see smarttech.com/kb/171532 for complete instructions
on completing an update with an MSP file.
NOTE
If SMART Product Update (SPU) is installed, updates appear in the SPU window and can be applied
locally if the teacher has administrative permissions for the computer.
IMPORTANT
You cannot roll back an update after installing it on the teachers’ computers. You must uninstall the full
version of the software using Control Panel or the command-line interface (see Chapter 8: Uninstalling
SMART Notebook on page 39), and then reinstall the previous version of the software.
To download the installer files
1. Go to smarttech.com/products/education-software/smart-learning-suite/admin-download.
2. Select the latest version of SMART Notebook.
3. Select Windows as the operating system.
4. Select the MSI installer.
5. Click DOWNLOAD - WINDOWS.
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6. Extract and save the installation packages in a location on your network that’s accessible to all
computers on which you plan to install the software. When the third-party installation packages are
unzipped, they can be found in the root of the Support folder.
To run a software update using a Windows Installer update installation package (MSI file)
Run the following command:
msiexec /i "[Path]\SMARTLearningSuite.msi" [Parameter]
Where
o

[Path] is the path to the MSI file.

o

[Parameter] is the installation parameter (see page 26).

IMPORTANT
Do not include the REINSTALLMODE and REINSTALL properties.
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After you deactivate the teacher’s access to SMART Notebook, you can use the SMART Uninstaller to
uninstall the software. The benefit of using the SMART Uninstaller over the Windows control panel is that
you can select other SMART software that’s installed on the computer, such as SMART Product Drivers and
Ink, to remove at the same time as SMART Notebook. The software is also uninstalled in the correct order.

Using the SMART Uninstaller to uninstall SMART
software
You can uninstall SMART Notebook and other SMART software from individual computers using the
SMART Uninstaller.
To uninstall SMART Notebook using the SMART Uninstaller
1. In Windows 7 operating system, select Start > All Programs > SMART Technologies > SMART Tools >
SMART Uninstaller.
OR
In Windows 8.1 operating system, go to the Apps screen and then scroll to and select
SMART Technologies > SMART Uninstaller.
OR
In Windows 10 operating system, tap Start, and then scroll to and select SMART Technologies >
SMART Uninstaller.
2. Click Next.
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3. Select the check boxes of the SMART software and supporting packages that you want to uninstall,
and then click Next.
NOTES
o

Some SMART software depends on other SMART software. If you select this software, the
SMART Uninstaller automatically selects the software that depends on it.

o

SMART Uninstaller automatically uninstalls supporting packages that are no longer being used.

o

If you uninstall all SMART software, SMART Uninstaller automatically uninstalls all supporting
packages, including itself.

4. Click Uninstall.
SMART Uninstaller uninstalls the selected software and supporting packages.
5. Click Finish.

Using the SMART Uninstaller command-line interface
In addition to the user interface, SMART Uninstaller provides a command-line interface. You can use this
interface to automate the removal of SMART Notebook and uninstall SMART Notebook remotely.
NOTE
SMART recommends that you copy SMART Uninstaller to a temporary location before running command
lines and prefix command lines with start /wait.
To uninstall all SMART software
1. Copy SMART Uninstaller to a temporary location by running one of the following commands:
copy "%CommonProgramFiles(x86)%\SMART Technologies\SMART Uninstaller\SMART
Uninstaller.exe" "%TEMP%"
2. Uninstall all software by running the following command:
start /wait "SMART Uninstaller" "%TEMP%\SMART Uninstaller.exe" --noui
--uninstall-all --uilevel none
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3. Delete the copy of SMART Uninstaller in the temporary location by running the following command:
del "%TEMP%\SMART Uninstaller.exe"

To uninstall SMART software by product name
1. Copy SMART Uninstaller to a temporary location by running one of the following commands:
copy "%CommonProgramFiles(x86)%\SMART Technologies\SMART Uninstaller\SMART
Uninstaller.exe" "%TEMP%"
2. Uninstall select software by running the following command:
start /wait "SMART Uninstaller" "%TEMP%\SMART Uninstaller.exe" --noui
--uninstall "[Product names]" --uilevel none
Where [Product names] is a comma delimited list of product names.
3. Delete the copy of SMART Uninstaller in the temporary location by running the following command:
del "%TEMP%\SMART Uninstaller.exe"

To uninstall SMART software by product code
1. Copy SMART Uninstaller to a temporary location by running one of the following commands:
copy "%CommonProgramFiles(x86)%\SMART Technologies\SMART Uninstaller\SMART
Uninstaller.exe" "%TEMP%"
2. Uninstall select software by running the following command:
start /wait "SMART Uninstaller" "%TEMP%\SMART Uninstaller.exe" --noui
--uninstall-pc [Product codes] --uilevel none
Where [Product codes] is a comma delimited list of product codes.
3. Delete the copy of SMART Uninstaller in the temporary location by running the following command:
del "%TEMP%\SMART Uninstaller.exe"
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Other commands
The following is a list of all the commands you can use with SMART Uninstaller.
Command

Description

Notes

--dry-run

Runs the command line but doesn’t
uninstall the software.

This is useful for testing command
lines before running them.

--locale [Language code]

Displays SMART Uninstaller in a
language other than the operating
system’s language.

The appropriate language pack must
be installed to display SMART
Uninstaller in the language.

Specifies the user interface that
displays when SMART Uninstaller
uninstalls the software.

Normally, --uilevel none is used
only in combination with --noui.

--no-auto-remove

Disables the automatic removal of
supporting packages (for example,
SMART Common Files) that are no
longer required after the selected
packages are uninstalled.

This is used only if --noui is also
included.

--noui

Doesn’t display the SMART Uninstaller
user interface.

Normally, --noui is used only in
combination with --uilevel none.

--uninstall-all

Uninstalls all detected SMART
packages.

[N/A]

--uninstall [Product names]

Uninstalls the specified products.

[N/A]

Uninstalls the specified products.

[N/A]

Where [Language code] is a language code (for
example, fr for French)
--uilevel [Level]
Where [Level] is one of the following:
l
l
l
l

none
basic (default)
reduced
full

Where [Product names] is a comma delimited list
of product names
--uninstall-pc [Product codes]
Where [Product codes] is a comma delimited list
of product codes. See Appendix F: Product codes on
page 60.
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In the SMART Admin Portal, you still have a product key (or multiple product keys) attached to your
subscription. You can use a product key to activate SMART Notebook software on a computer, but it is
more beneficial to provision a teacher’s email address. Provisioning grants access to a person, allowing
teachers to sign in through their SMART accounts and use SMART software on any device on which it's
installed. Using a product key activates SMART Notebook only on a specific computer.
The following table outlines the main differences between each method. Review this table to determine
which method works for your school.
Feature

Provisioning emails

Product key

Simple activation

Teachers sign in to their SMART account

The product key is entered

SMART account sign in
required

When teachers sign in to their SMART account in
SMART Notebook, it activates their access to the
software and popular features, such as student
device contributions and sharing lessons to
SLS Online.

Signing in does not activate a teacher’s access.
Teachers must enter their product key separately.

Assigning a user to your school’s subscription
provisions that user to sign in to their SMART
account and use SMART software on any device on
which it’s installed for as long as the subscription is
active. The activation follows the user, not the
computer. To use SMART Notebook at home,
teachers just download and install the software,
then sign in to their account.

Activating desktop software with a product key
works for that one computer. A product key follows
the computer only.

Home use
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Teachers sign in to their SMART account in
SMART Notebook to access to popular features,
such as enabling student device contributions and
sharing lessons to SLS Online.

Although teachers could use the same product key
to activate SMART Notebook on a home computer,
more product key seats from your school’s
subscription might be used.
Activation with a product key provides no way to
revoke the activation, such as when a teacher starts
working for a different district or in the event of
unauthorized use of a product key.
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Feature

Provisioning emails

Product key

Subscription renewal
management

When the subscription is renewed, you only have to
manage it from the SMART Admin Portall.

The product key entered must be renewed.
Otherwise, you must give teachers an active product
key from your school’s subscription and have them
enter it in SMART Notebook.

Also, if your organization has multiple product keys,
renewals are easier to manage because
provisioning is not associated with a single product
key in the SMART Admin Portal. If a product key
expires and is not renewed or a new product key
was purchased or given to you when your school
renewed its subscription, the provisioning can be
moved to another active product key without
requiring the teacher to change anything in the
software.
Activation control and
security

You can deactivate a provisioned account from the
SMART Admin Portal, so there’s no risk of a product
key being shared or used outside your organization.

After you share a product key or enter it in
SMART Notebook, the product key is always visible in
the SMART Notebook interface.
There is no way to prevent teachers sharing their
key or using it to activate SMART Notebook on more
than one computer. This can affect the available
seats associated with a product key and
subscription. There’s no way to control the number
of activations on a single product key.

Return a departing
teacher’s access
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If a teacher departs the school, you can easily
deactivate the provisioned account and return the
seat to the school’s subscription.

Before a teacher departs, you must deactivate
SMART Notebook on the teacher’s work computer
and home computer (if applicable). There is no way
to revoke a product key on a computer that has
stopped working or is inaccessible.
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Why teachers need a SMART Account
When using SMART Notebook, teachers need to sign in using their SMART account credentials to access
premium features and use many common features, such as:
l

Create interactive activities and assessments and enable student device contributions for those
activities and assessments

l

Keep the same class code when students sign in to play collaborative activities

l

Share SMART Notebook lessons to their SMART account so they can and present those lessons on
any device using SMART Learning Suite Online or using the embedded Player app on a SMART Board
interactive display with iQ

l

Share lessons with an online link

l

Upload and share SMART Notebook lessons with their students through SMART Learning Suite Online.
This enables teachers to share or present their lessons from any device, regardless of operating
system. This is particularly beneficial for schools that use Chromebooks.

How teacher’s can register for a SMART account
To register for a SMART account, you need an existing Google or Microsoft account profile—ideally from
an account provided by your school for Google Suite or Microsoft Office 365.
If you already have a Google or Microsoft account profile linked to a SMART application, use that email
address to set up your SMART account. This connects all your SMART applications through a single
account.
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To create a SMART account using the teacher’s existing Google or Microsoft account
1. Select an account provider—this is another organization where you already have an account.
SMART will use the account you choose (and the associated email and password) to create your
SMART account.
TIP
If you’re a teacher, ask an IT person at your school if your school email address is already connected
to one of the account providers shown above. If it is, that’s the account and email address you
should use to set up your SMART account.
Your account provider’s sign-in dialog appears.

2. Follow the on-screen instructions to sign into your account provider. You’ll be asked to enter or select
your email address and then enter your password.
After you sign in to your account provider, you’re returned to SMART’s account creation wizard.
3. Enter a display name and select Next.

IMPORTANT
Your display name is publicly visible to all your students. Choose a display name that you want your
students to see and use to address you.
4. After you’ve entered your display name, a confirmation message appears.
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Gallery content includes the following:
l

Gallery Essentials, which is a collection of educational photos, images, and audio files compatible
files.

l

Lesson Activity Toolkit, which contains objects teachers can use to create their own lesson activities.

Configuring Gallery content using SMART Install
Manager
If you’re customizing the software using SMART Install Manager, complete the procedure in this section to
configure Gallery content.
To configure Gallery content using SMART Install Manager
1. Open the software installation package in SMART Install Manager.
2. Click Product Selection.
3. Select SMART Notebook (and any other products you want to install).
4. Click Gallery Content.
The Gallery Content page appears.
5. Select the Gallery content (Gallery Essentials and/or Lesson Activity Toolkit) to be installed on each
computer:
6. Publish your changes, and then deploy the files.
If you loaded the ESI .EXE with Install Manager, publish will produce a .xml file.
If you loaded the ESI .MSI with Install Manager, publish will produce a .mst file.
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7. Make sure the .xml or .mst file is saved into the same folder as the ESI installation package to be
deployed.

Updating and adding Gallery content locations
After you install SMART Notebook, you can make changes to Gallery content in a number of ways:
Action

Reason

Start the
Before you can make changes to content folders, you must start the software in
software in
Administration mode.
Administration
mode
Change the
Teachers and students can use the My Content folder to store content for their individual
location of the use.
My Content
You can specify the location of the My Content folder during or after installation.
folder
Create or
All users can create new content and save it in their My Content folders. To allow users to
connect to a
share content, you must create or connect to a Team Content folder.
Team Content
TIP
folder
If you create a Team Content folder on a computer’s hard disk, the folder is available
only to users of that computer. However, if you create a Team Content folder on the
network, the folder is available to all users on the school’s network with read and write
access to the folder.
Connect to an You can connect to a public or private RSS feed to send information to your school’s
RSS feed
SMART Notebook software through the Gallery tab.
RSS is a format for delivering regularly changing web information. Many news-related
websites, blogs, and other publishers broadcast as RSS feeds.

To start SMART Notebook software in Administration mode
1. Open a command prompt window.
2. Run the following command:
"[Path]\Notebook.exe" /admin
Where [Path] is the path to the SMART Notebook software program folder.
3. Click ENTER.
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To change the location of the My Content folder after installation
1. Start the software in Administration mode.
2. Click the Gallery tab.
3. Click the Click here for more Gallery options icon , and then select Administration: Content
Locations.
The Administration: Content Locations dialog box appears.
4. Click Browse.
5. Browse to and select the new My Content folder, and then click OK.
6. Click Close.
7. Close the software.
To create a new Team Content folder
1. Start the software in Administration mode.
2. Click the Gallery tab.
3. Click the Click here for more Gallery options icon, and then select Administration: Content
Locations.
The Administration: Content Locations dialog box appears.
4. Click Connect to Team Content.
5. Browse to and select the folder you want to designate as a Team Content folder, and the click OK.
NOTE
The software adds an imsmanifest.xml file to the Team Content folder after you click OK.
This file identifies the folder as a Team Content folder.
6. Click Close.
7. Close the software.
To connect to an existing Team Content folder
1. Start the software in Administration mode.
2. Click the Gallery tab.
3. Click the Click here for more Gallery options icon, and select Administration: Content Location.
The Administration: Content Location dialog box appears.
4. Click Add Existing.
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5. Browse to and select the Team Content folder, and then click OK.
6. Click Close.
7. Close the software.
To disconnect a Team Content folder
1. Start the software in Administration mode.
2. Click the Gallery tab.
3. Click the Click here for more Gallery options icon, and then select Administration: Content
Locations.
The Administration: Content Locations dialog box appears.
4. Select the folder in the Team Content list, and then click Remove.
IMPORTANT
If you installed the Gallery Essentials and Lesson Activity Toolkit collections, folders for those
collections appear in the Team Content list. Do not remove these folders from the list, or users will
not be able to access these collections.
5. Click Close.
6. Close the software.
To connect to an RSS feed
1. Start the software in Administration mode.
2. Click the Gallery tab.
3. Click the Click here for more Gallery options icon , and then select Administration: Content
Locations.
The Administration: Content Locations dialog box appears.
4. Type the URL of the RSS feed in the Online Resources box.
5. Click Close.
6. Close the software.
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Installation language files and codes
Language

Code

File

English (U.S.)

1033

1033.mst

English (UK)

2057

2057.mst

Arabic

1025

1025.mst

Chinese (Simplified)

2052

2052.mst

Chinese (Traditional)

1028

1028.mst

Czech

1029

1029.mst

Danish

1030

1030.mst

Dutch

1043

1043.mst

Estonian

1061

1061.mst

Finnish

1035

1035.mst

French (France)

1036

1036.mst

German

1031

1031.mst

Greek

1032

1032.mst

Hebrew

1037

1037.mst

Hungarian

1038

1038.mst

Italian

1040

1040.mst

Japanese

1041

1041.mst

Kazakh

1087

1087.mst

Korean

1042

1042.mst

Latvian

1062

1062.mst

Lithuanian

1063

1063.mst

Norwegian

1044

1044.mst
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Language

Code

File

Polish

1045

1045.mst

Portuguese (Brazil)

1046

1046.mst

Romanian

1048

1048.mst

Russian

1049

1049.mst

Spanish (Spain)

1034

1034.mst

Slovak

1051

1051.mst

Slovenian

1053

1053.mst

Swedish

1060

1060.mst

Turkish

1055

1055.mst

Ukrainian

1058

1058.mst

Vietnamese

N/A

N/A

NOTE
The SMART Notebook installer doesn’t support
Vietnamese translations.

Handwriting recognition resources
The SMART Learning Suite 16 and later language packs contain handwriting recognition resources only.
Additional localization resources previously contained in language packs are included in the product
installation files.
File

Code

arabic_handwriting.msi

{648C7144-1B6F-497B-9F1A-6DFE8773816E}

chinese_(simplified)_handwriting.msi

{CA05B824-9AA6-455B-8DF5-2453C865FAF3}

chinese_(traditional)_handwriting.msi

{74B9E115-5E23-4928-92E3-73B8631AA524}

czech_handwriting.msi

{65A75580-36A0-4490-8181-0967DD6C1464}

danish_handwriting.msi

{6218930D-3F77-4768-8C43-CD3FA4168914}

dutch_handwriting.msi

{B4D49CAE-EF29-4775-B0BA-0DFD6B2D69D9}

english_(united_kingdom)_handwriting.msi

{B5D5D9DC-3361-43D7-ADED-916CC6E90A03}

estonian_handwriting.msi

{87C03A3D-8B0B-424D-AE43-4ECD74C3CC8E}

finnish_handwriting.msi

{D2BFFB26-00CD-4CA3-932F-818A5C8C7CD8}

french_handwriting.msi

{EF73F0B8-7EBE-4D36-92FA-6BF638F52732}

german_handwriting.msi

{2B73B4A7-03E4-437F-9E7F-AE533A93D4A2}

greek_handwriting.msi

{5066774D-FF40-45EA-B797-F7F36DBC70B7}
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File

Code

hebrew_handwriting.msi

{3623E3DE-104A-4651-B8E3-9D2851636A2F}

hungarian_handwriting.msi

{3AE061AF-B255-4052-9918-849AD4FE0C56}

italian_handwriting.msi

{AF09A64A-245A-458A-8290-421D611A21F5}

japanese_handwriting.msi

{3FB8FA79-CAF4-47CD-A599-D68F72D1CAD1}

kazakh_handwriting.msi

{36D656E4-A38A-4D54-A58E-7A4AC2CDE5F4}

korean_handwriting.msi

{C106402C-BC3E-4EA4-A3AE-6BDBCB785DC3}

latvian_handwriting.msi

{0EB8A795-CCF7-46CD-9E8A-1739A539A382}

lithuanian_handwriting.msi

{EE96CAF4-2439-4CD9-BFF7-DC3DFBC7781B}

malay_handwriting.msi

{33A07CFE-B356-45A7-B2E5-99F536CC84B9}

norwegian_handwriting.msi

{AE4A8476-F602-4FC0-A40D-336DC76DD7EE}

polish_handwriting.msi

{11725848-ECA6-4E79-874C-E59D1DA6A122}

portuguese_(brazil)_handwriting.msi

{3C2062D0-82F6-4CE3-ADAD-F993CBE2F4F5}

romanian_handwriting.msi

{84BCEABF-4624-447D-89D8-5D0B5F4DFFBC}

russian_handwriting.msi

{4CF5A60A-8E02-4376-A9F5-8C343D473FCD}

slovak_handwriting.msi

{5E6F10F3-9006-4F78-B231-18866B792E06}

slovenian_handwriting.msi

{A85B8742-487B-4D66-92C2-1687F23889A8}

vietnamese_handwriting.msi

{7EE498CF-EFBC-4B15-B42D-0DBAE6FBC693}

spanish_handwriting.msi

{62F6F0A3-FB04-4FDF-ABB4-11F3A042EB8A}

swedish_handwriting.msi

{9B9B50A8-84A4-4547-A9E5-FA3868CDF78B}

turkish_handwriting.msi

{9D3E3459-395A-4514-8C67-064C123C77C4}

ukrainian_handwriting.msi

{CEAEC5BE-99AA-4D82-A06D-4D5B5895DB3F}

vietnamese_handwriting.msi

{A85B8742-487B-4D66-92C2-1687F23889A8}
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Use the following properties if you’re plan to use a third-party tool and Windows Installer properties to
customize the installation of SMART software.
Property

Allowed values

Notes

[String]: A language MST file for the installation (see
Installation language files and codes on page 51).

Ensure the specified MST file is in the same folder as
the MSI file.

General properties
TRANSFORMS

This property defines the language of the installer’s
user interface and the installed software’s icons and
shortcuts. It doesn’t define the installed software’s
user interface language. The installed software uses
the computer’s operating system language if it’s
supported, or English (U.S.) if not.
You can also use the TRANSFORMS property to
apply an MST file created by SMART Install Manager
or a third-party tool.

MSIFASTINSTALL

1: Disable creating a system restore point.
0 (default): Ask Windows to create a system restore
point.

This property applies to the complete installer (EXE)
only. The MSI installer follows Windows Installer
conventions and doesn’t create a system restore
point in quiet (/qn) mode, but asks Windows to create
a system restore point in full, reduced or basic
UI modes.
By default, Windows 8.1 operating system and later
creates a maximum of one system restore point in a
24-hour period.

ACTIVATE_
LICENSE

1 (default): Register the product keys and
automatically activate the software.
0: Register the product keys and don’t automatically
activate the software (delay activation). Registered
keys can be activated when users start
SMART Notebook software.

DISABLE_NAG

1: Prevent the software activation reminder from
appearing after SMART Notebook software starts.
0 (default): Allow the software activation reminder to
appear after SMART Notebook software starts.

INSTALL_BOARD

1: Install SMART Product Drivers.

Delaying activation (0) is useful for uniform
deployments that include users who don’t use
SMART Notebook software. Only users who start
SMART Notebook software activate registered keys
and consume a license.

When 1 is selected, the software activation reminder
appears only when the SMART Notebook software
trial period expires.

[N/A]

[Empty string]: The product is turned off.
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Property

Allowed values

Notes

LAUNCH_SYSTEM_
MENU

1 (default): Automatically start SMART System Menu
after installation and each time the system is started.

[N/A]

[Empty string]: Don’t automatically start SMART
System Menu after installation and each time the
system is started.
INSTALL_INK

1: Install SMART Ink

[N/A]

[Empty string]: The product is turned off.
INSTALL_NOTEBOOK

1: Install SMART Notebook software.

[N/A]

[Empty string]: The product is turned off.
NB_PROD_KEY

[String]: The 25-character product key for
SMART Notebook software you received from
SMART.

[N/A]

MATH_PROD_KEY

[String]: The 22- or 25-character product key for
SMART Notebook Math Tools software you received
from SMART.

[N/A]

UNINSTALL_EXISTING

1: Remove SMART software products available in the
current SMART Learning Suite package found on
any machine on your system (except any SMART
products you included in your command).

This enables you to remove any software in the
current package that isn’t included in your
command.

[Empty string] (default): Upgrade all SMART Learning
Suite software found on your system, even if the
SMART software isn’t selected above.
INSTALLDIR

[String]: Type the path to your preferred folder
where program installation files are stored.

[N/A]

Once you specify the path, selected programs are
installed in sub-directories of this location
DESKTOP_ICONS

1 (default): Creates desktop shortcuts to the
software.

[N/A]

[Empty string]: Does not create desktop shortcuts.
CR_ENABLED

1 (default): Enables SMART Technologies Error
Report.

[N/A]

0: Disables SMART Technologies Error Report.
ENABLE_SLS_TRIAL

1 (default): Enables the ability for users to start a
SMART Learning Suite trial.
0: Disables the ability to start a SMART Learning
Suite trial.

ENABLE_EXPIRY_
WARNINGS

1 (default): Enables in-product subscription expiry
notifications.
0: Disables in-product subscription expiry
notifications.

A trial provides users with access to the additional
SMART Notebook features that come with the
subscription.

If enabled, SMART Notebook will display a
notification for upcoming subscription expiry at at 95,
55, 25, and 15 days before the expiry date. This
notification is only displayed once for each time
interval.

SPU properties
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Property

Allowed values

Notes

INSTALL_SPU

1 (default): Install SPU in Full mode.

In Full mode, SPU shows which SMART software is
installed, the software’s activation status (if
applicable), and indicates whether updates are
available.

2: Install SPU in Dashboard mode.
0: Don’t install SPU.

In Dashboard mode, SPU shows which SMART
software is installed and the software’s activation
status is (if applicable). It does not indicate availability
of updates for the installed software.
SPU_TIME_
FRAME

[Integer]: The time in days (1 to 60) between SPU
checks.

By default, SPU checks for product updates every 30
days.
This property is applicable only if you install SPU.

PRODUCT_
NOTIFICATION

1 (default): Notify the user when updates are
available from SPU.

This property is applicable only if you install SPU.

0: Don’t notify the user when updates are available
from SPU.
INVALIDATE_HKCU_
INTERVAL

1: Remove existing Check for updates and Notify
users about SMART product updates values the
next time the user runs SPU.
0 (default): Don’t remove existing Check for
updates and Notify users about SMART product
updates values the next time the user runs SPU.

This enables administrators to push new values for
these settings to computers and ensures the new
values are accepted. Individual users can still modify
these settings

Customer Experience Program properties
CUSTOMER_
LOGGING

1 (default): Enable the Customer Experience
Program.

[N/A]

0: Disable the Customer Experience Program.
SMART Notebook software properties
FULL_GALLERY

1: Install the full Gallery.

[N/A]

[Empty string]: The Gallery is turned off.
LAT_CONTENT

1: Install the Lesson Activity Toolkit collection.

[N/A]

[Empty string]: The Lesson Activity Toolkit is turned
off.
TEAM_CONTENT_
PATH

[String]: Specify the path to the Team Content
folder, which is a location on your school’s network
where users can store shared content.

You must specify a path to an existing folder in this
property.

MY_CONTENT

[String]: Specify the path to the My Content folder,
which is a location on the user’s computer where he
or she can store individual content.

You can include environment variables in the path.

1 (default): Install the Print Capture Driver.

The Print Capture Driver is a printer driver that
enables users to export content from other
programs to SMART Notebook software by using
the SMART Notebook Document Writer.

PRINT_CAPTURE

[Empty string]: Don’t install the Print Capture Driver.
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Property

Allowed values

Notes

INSTALL_DOCCAM_
DRIVERS

1 (default): Enable the registration of SMART
Document Camera drivers.

Disable the registration of SMART Document
Camera drivers if they conflict with existing thirdparty drivers on the computer.

[Empty string]: Disable the registration of SMART
Document Camera drivers.
ENABLE_NB_FIREWALL

1 (default): Allow SMART Notebook software to
communicate through the Windows Firewall for
advanced NBSDK functionality.

This property updates the Windows Firewall
exception list for Domain and Private networks.

0: Don’t allow SMART Notebook software to
communicate through the Windows Firewall.
SMART Notebook software can listen locally but is
unable to communicate through the Windows
Firewall.
SMART Product Drivers properties
ENABLE_
STPCS

START_SNMP_
SERVICE
INSTALL_UNSIGNED_
DRIVERS

1 (default): Use Tablet PC functionality with the
SMART Board interactive whiteboard without
connecting a Tablet PC.

This property is applicable for the Windows 7
operating systems. It has no effect on other
operating systems.

0: Don’t use Tablet PC functionality with the
SMART Board interactive whiteboard without
connecting a Tablet PC.

If you specify 0, users don’t have touch support at
the Windows logon screen.

1: Start Simple Network Management Protocol
(SNMP) when the user logs on.

[N/A]

0 (default): Don’t start SNMP when the user logs on.
1: Enable the registration of unsigned third-party
drivers.
0 (default): Disable the registration of unsigned thirdparty drivers.

If you enable the registration of unsigned third-party
drivers, the installation process could ask users if
they trust the makers of the drivers during
installation. This can cause issues if you deploy the
installation in Silent mode. Therefore, it’s best to
disable the registration of third-party drivers if you
deploy the installation in Silent mode.

1 (default): Start SMART Ink when the user logs on.

[N/A]

SMART Ink properties
LOSU_INK

0: Don’t start SMART Ink when the user logs on.
Handwriting recognition resources properties
Select up to 18 handwriting recognition resources if you’re running an administrator installation with the SMARTLearningSuite.msi
file (see smarttech.com/kb/170081).
AR

1: Install the Arabic handwriting recognition
resource.

[N/A]

ZH_CN

1: Install the Chinese (Simplified) handwriting
recognition resource.

[N/A]

ZH_TW

1: Install the Chinese (Traditional) handwriting
recognition resource.

[N/A]

CS

1: Install the Czech handwriting recognition
resource.

[N/A]
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Property

Allowed values

Notes

DA

1: Install the Danish handwriting recognition
resource.

[N/A]

NL

1: Install the Dutch handwriting recognition resource.

[N/A]

EN_GB

1: Install the English (UK) handwriting recognition
resource.

[N/A]

ET

1: Install the Estonian handwriting recognition
resource.

[N/A]

FI

1: Install the Finnish handwriting recognition
resource.

[N/A]

FR

1: Install the French handwriting recognition
resource.

[N/A]

DE

1: Install the German handwriting recognition
resource.

[N/A]

EL

1: Install the Greek handwriting recognition
resource.

[N/A]

HE

1: Install the Hebrew handwriting recognition
resource.

[N/A]

HU

1: Install the Hungarian handwriting recognition
resource.

[N/A]

IT

1: Install the Italian handwriting recognition resource. [N/A]

JA

1: Install the Japanese handwriting recognition
resource.

[N/A]

KK

1: Install the Kazakh handwriting recognition
resource.

[N/A]

KO

1: Install the Korean handwriting recognition
resource.

[N/A]

LT

1: Install the Lithuanian handwriting recognition
resource.

[N/A]

LV

1: Install the Latvian handwriting recognition
resource.

[N/A]

MS

1: Install the Malay handwriting recognition resource.

[N/A]

NB

1: Install the Norwegian handwriting recognition
resource.

[N/A]

PL

1: Install the Polish handwriting recognition resource.

[N/A]

PT_BR

1: Install the Portuguese (Brazil) handwriting
recognition resource.

[N/A]

RO

1: Install the Romanian handwriting recognition
resource.

[N/A]
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Property

Allowed values

Notes

RU

1: Install the Russian handwriting recognition
resource.

[N/A]

SK

1: Install the Slovak handwriting recognition
resource.

[N/A]

SL

1: install the Slovenian handwriting recognition
resource.

[N/A]

ES

1: Install the Spanish (Spain) handwriting recognition
resource.

[N/A]

SV

1: Install the Swedish handwriting recognition
resource.

[N/A]

TR

1: Install the Turkish handwriting recognition
resource.

[N/A]

UK

1: Install the Ukrainian handwriting recognition
resource.

[N/A]

VI

1: Install the Vietnamese handwriting recognition
resource.

[N/A]

Internet access properties
ACC

[Integer]: Enable Internet access for specified
components.
l

0: No components

l

2: Language Setup

l

4: SMART Product Update
8: Customer Experience Program

l

13: All components except Language Setup

l

15 (default): All components

l
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Appendix F

Product codes

The following table provides a list of product codes for SMART software. Use these codes when using the
command line interface to uninstall SMART software by product name.
Version

Product code

SMART Notebook software

11.4

{79660EE7-9C0B-4962-B566-2693FE34719D}

14.0

{4DF72C85-33C5-4297-A0DE-FC6DB766695D}

14.1

{84579080-E961-4DE7-93AB-5E2B81A96387}

14.2

{D4C0DEF0-8D83-4884-91D9-83A07D0F2CB5}

14.3

{18E53BBD-971F-4A77-9620-EB2C1539E308}

15.0

{955F23AC-CABC-4F34-A3E4-3DF2305B64BE}

15.1

{5E112563-E291-4C20-849F-49CE3BAD73D1}

15.2

{E6EE86DD-5B8B-483D-83EB-18B9E1FD9BB8}

16.0

{47F91537-12BD-4B30-8726-5A033FE61CDA}

16.1

{AA217CD3-F8C1-4AEA-A145-5850078BFB17}

16.2

{87948734-3F7C-4E9D-8702-3B05AF3CDA23}

17.0

{6C0FDF5B-142D-4F0D-8DED-3B563A20B033}

17.0.1

{5EBEDBC2-0986-4311-8C52-52C5C69E8182}

17.1

{ACB84BD5-8E84-4103-B611-9836534DED54}

18.0

{A93177EC-FC8C-4DE5-9988-BD36B93D1B66}

18.1

{38AB20FE-C03E-47B2-A769-F2E548031F9B}

19.0

{67A22506-25EF-4F7A-97A8-9293345093E1}

19.0 SP2

{24C8FC45-E93F-4A3A-A377-64DCE1C336C5}

19.1

{F0215213-10A6-43DB-9BE4-3FD3DB5D8E53}

20.0

{4350F5AF-AEBF-4914-BB1C-847AF59E9BEC}
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Version

Product code

SMART Product Drivers

11.4

{53330A17-78DE-458E-9997-292A2D6D3ADD}

11.5

{B1209081-5D82-4F8A-8318-BE7583B6E265}

11.6

{890680EC-2F88-47F0-970C-593081E62593}

12

{111A1715-267A-4387-B63D-D7E6E7D97677}

12.1

{67F35E75-A186-4F80-B291-8283331D5550}

12.2

{C3C9E674-3FD2-4535-B733-C7C62074DC4A}

12.3

{A418B556-1E81-4D42-B54E-979720B3DEBF}

12.4

{BFF16FAE-1B84-40EA-B60E-385F5A392512}

12.5

{696243E7-E4BB-4696-ACF0-C6D2FC012136}

12.6

{1E280E41-ED8E-424C-9EA9-FD52963B21BE}
(bundled with SMART Notebook 16.1)
{3298B999-38D0-4650-8FB7-3C9E71325465}
(bundled with SMART Notebook 16.2)

12.7

{1E280E41-ED8E-424C-9EA9-FD52963B21BE}

12.8

{A292B5F2-F55A-4960-A58F-07569554D321}

12.9

{663AF146-1736-49B3-B96D-A1006692BB0E}

12.10

{91BF2AF1-380E-46EB-A49A-7CFE80B59631}

12.11

{3DC4D966-FBCF-45E5-AC7E-9ED104AA3132}

12.13

{BF782898-838D-4FA4-9D3E-FC6F27E76D89}

12.14

{36BCCBF2-5D85-423F-B759-63582FECE7C2}

12.15

{8F02AE90-9219-42E6-AD41-0C0055227B9B}

12.16

{0405B16D-65AF-4D2F-955B-32E10232A47E}

SMART Ink

2.0

{5ABC49B5-D0DC-428D-A082-4AEFF6490F04}

2.1

{B4F5D378-9784-442B-97D5-24CAAF3299AA}

2.2

{FC69B741-DC56-4591-97A2-A6BA211B7E76}

2.3

{FAF3CC40-F647-4AA7-84D6-7BD67C4F2362}

2.3.1

{232C8EC0-4856-4EEA-B99F-5FCC4E103A09}

3.1

{52ECF84B-09E9-4C98-B4FD-17EE1BC09921}
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Product code

3.2

{57E67FAF-87D9-4573-BC7F-C95B1A71287A}

4.0

{A5AEF478-1170-4335-86B8-561328B193EC}

4.1

{7AB1FDF1-6998-43AD-B705-EA8AF7439407}

4.2

{11ECCC34-FC75-4DA0-B13D-E89D1E6661BF}

5.0

{89E25BCE-F949-405E-ADA9-8537B4F4E2B8}

5.1

{A292B5F2-F55A-4960-A58F-07569554D321}

5.2

{A60BAFDD-6BFF-4F65-8364-499ED8EB91DB}

5.3

{1805AF15-EFAC-4C99-824B-81EC8CD6DC66}

5.4

{1B6934C5-BA75-4C7D-B3BA-D73B4DDB42A5}

5.5

{1B6934C5-BA75-4C7D-B3BA-D73B4DDB42A5}

5.6

{B6DB1342-5B04-471D-97C5-9D27C5C1D6CF}
(bundled with SMART Notebook 19.0)
{431EB801-5D66-409A-B208-AEF76AD7F677}
(bundled with SMART Notebook 19.1)

5.7

{3AF320CE-8571-46D1-B2C0-6F95A2E03B9F}

SMART Common Files

2013 (11.3)

{BBA07B40-F7C6-44F7-BF08-767F8835685F}

2013 (11.4)

{26A95DBF-A866-4838-A8C9-FA219FCBD22E}
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